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 Important Information

Warranty
The NI PXI-1052 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
CVI™, LabVIEW ™, Measurement Studio™, National Instruments™, NI™, ni.com™, NI-DAQ™, NI-VISA™, and SCXI™ are trademarks of 
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
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About This Manual

The NI PXI-1052 User Manual contains information about installing, 

configuring, using, and maintaining the NI PXI-1052 chassis.

Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on 

the product, refer to the Read Me First: Safety and Radio-Frequency 

Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product it denotes a warning advising you to 

take precautions to avoid electrical shock.

When symbol is marked on a product it denotes a component that may be 

hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.
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Related Documentation

The following documents contain information that you might find helpful 

as you read this manual:

• DAQ Quick Start Guide

• SCXI Quick Start Guide

• DAQ user manuals and installation guides—This documentation has 

detailed information about the DAQ hardware that plugs into or is 

connected to the chassis. Use these documents for hardware 

installation and configuration instructions, specification information 

about the DAQ hardware, and application hints.

• Getting Started with SCXI—Read this manual second. It gives an 

overview of the SCXI system and contains the most commonly needed 

information for modules, chassis, and software.

• SCXI user manuals and installation guides—Read these documents 

next for information about signal connections and module 

configuration. They also explain in greater detail how the module 

works and contain application tips and strategies.

• PXI Hardware Specification, Revision 2.1

• CompactPCI Specification PICMG 2.0 R 3.0

• PXI Software Specification, Revision 2.1

• SCXIbus System Specification

• IEEE 1101.1-1991, IEEE Standard for Mechanical Core 

Specifications for Microcomputers Using IEC 603-2 Connectors

• IEEE 1101.10, IEEE Standard for Additional Mechanical 

Specifications for Microcomputers Using IEEE 1101.1 Equipment 

Practice

Note While some of the NI documentation listed in this section is included with your kit, 

all of the NI documents are available at ni.com/manuals. The listed specifications are 

not available through NI. They can be obtained from their respective organizations.
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1
Getting Started

This chapter describes the key features of the PXI-1052 chassis and lists 

the kit contents and optional equipment you can order from NI.

Unpacking

• Carefully inspect the shipping container and the chassis for damage.

• Inspect the chassis for visible damage to the metal work. Make sure all 

handles, hardware, and switches are undamaged. 

• Inspect the inner chassis for any possible damage, debris, or detached 

components. If damage appears to have been caused during shipment, 

file a claim with the carrier.

• Retain the packing material for possible inspection and/or reshipment.

Caution Many components within the chassis are susceptible to static discharge damage. 

Observe standard precautions for static-sensitive devices while handling the chassis.

What You Need to Get Started

The PXI-1052 kit contains the following items:

❑ PXI-1052 chassis

❑ AC power cable—refer to Table 1-1 for AC power cables

❑ NI PXI-1052 User Manual

❑ Read Me First: Safety and Radio-Frequency Interference

❑ NI PXI Chassis Resource CD

❑ PXI Filler panels

❑ (Optional) SCXI Filler panels

❑ (Optional) Chassis number labels
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If you are missing any of the items in Table 1-1, or if you have the incorrect 

AC power cable, contact NI through the information given in Appendix C, 

Technical Support and Professional Services.

Key Features

The PXI-1052 chassis combines a high-performance 4-slot PXI subsystem 

with an 8-slot SCXI subsystem, offering a complete solution for signal 

conditioning and switching applications. The PXI-1052 complies with the 

PXI Hardware Specification, Revision 2.1, offering advanced timing and 

synchronization features. The eight SCXI slots integrate signal 

conditioning modules into the PXI system. These modules provide analog 

and digital signal conditioning, isolation, and other functions. The 

PXI-1052 has a high-output power supply and structural design that is 

optimized for use in a wide range of applications.

The PXI-1052 has a built-in digital and analog bus between the PXI and 

SCXI subsystems that allows a DAQ/DMM module in the fourth PXI slot 

to control the SCXI subsystem without additional cables. The SCXI 

subsystem provides a low-noise environment for signal conditioning 

instrumentation. It supplies power and control circuitry for SCXI modules.

The key features of the PXI-1052 include the following:

• PXI and CompactPCI (PICMG 2.0 R 3.0) module compatibility

• 3U-sized, 4-slot PXI chassis subsystem

• Universal AC input: automatic voltage and frequency ranging

• Temperature-sensing module that adjusts fan speed based on air-intake 

temperature to minimize audible noise

Table 1-1.  AC Power Cables

Power Cable Reference Standards

Standard 120 V (USA) ANSI C73.11/NEMA 5-15-P/IEC83

North America 120 V ANSI C73.20/NEMA 5-15-P/IEC83

Switzerland 220 V SEV

Universal Euro 230 V CEE (7), II, IV, VII IEC83

Australia 240 V AS C112

United Kingdom 230 V BS 1363/IEC83
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• Over-current protection through push-reset circuit breaker 

(no AC-input fuse to replace)

• Remote PXI voltage monitoring and inhibit through a rear-panel 

connector

• On/Off (Standby) power switch on the front panel for easy access

• SCXI power switch on the chassis rear panel

• Front-panel LED that indicates power supply failure

• Handle for portability

• Tilt feet for bench-top applications

• Rack mountable
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Chassis Description

Figure 1-1 and Figure 1-2 show the key features of the PXI-1052 chassis 

front and rear panels.

Figure 1-1.  Front View of the PXI-1052 Chassis

1 On/Off (Standby) System Power Switch
2 System Power Indicator LED
3 SCXI Subsystem Power Indicator LED
4 SCXI Low-Voltage Analog Bus Connector
5 SCXI High-Voltage Analog Bus Connector
6 PXI Filler Panel
7 SCXI High-Voltage Backplane
8 Removable Feet
9 SCXI Subsystem Backplane

10 SCXI Module Slots
11 PXI Peripheral Slots
12 PXI Star Trigger/Peripheral Slot
13 PXI System Controller Slot
14 PXI Controller Expansion Slots
15 PXI Subsystem Backplane
16 Removable Handle
17 PXI Backplane Connectors
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Figure 1-2.  Rear View of the PXI-1052 Chassis

Optional Equipment

Contact NI to order the following options for the PXI-1052 chassis.

• EMC filler panel kits for PXI

• Filler panel kits for SCXI

• Front and rear rack-mount kits for mounting the PXI-1052 chassis into 

a 19 in. instrument cabinet

• PXI slot blocker kits for improved thermal performance when all slots 

are not used

PXI-1052 Backplane Overview

This section gives a basic hardware overview of the PXI-1052 backplane, 

with interoperability information for the PXI-1052 with CompactPCI, and 

general information about the local bus, including system controller slot, 

the star trigger slot, and the peripheral slots. 

1 Filter Retainer Screws
2 SCXI Subsystem Power Switch
3 Remote Inhibit and Voltage Monitoring Connector
4 Fan Speed Selector Switch
5 Filter Cover
6 Universal AC Inlet

7 Chassis Ground Screw
8 Circuit Breaker
9 SCXI Auxiliary I/O Connector
10 SCXI High-Voltage Analog Bus Connector
11 SCXI Low-Voltage Analog Bus Connector

13 421

11

10

9

8
7 6 5 1
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Interoperability with CompactPCI
The PXI-1052 backplane is interoperable with 5 V and universal 

PXI-compatible products and standard CompactPCI products. This is an 

important feature because some PXI user systems can require components 

that do not implement PXI-specific features. For example, you may want 

to use a standard CompactPCI network interface card in a PXI chassis.

The signals on the backplane P1 connectors meet the requirements of the 

CompactPCI specification for both peripheral and system modules. Refer 

to Appendix B, Pinouts, for pinout information.

The PXI-specific signals are on the backplane P2 connectors and are found 

only on those signal lines reserved or not used in the CompactPCI 64-bit 

specification. Therefore, all modules that meet the requirements of the 

CompactPCI 64-bit specification function in the PXI-1052. Refer to 

Appendix B, Pinouts, for pinout information.

The PXI-1052 backplane has +5 V V(I/O). Refer to the CompactPCI 

Specification PICMG 2.0 R3.0 for details regarding V(I/O).

System Controller Slot
The system controller slot is Slot 1 of the chassis as defined by the PXI 

specification. There are three controller expansion slots to the left of Slot 1 

for system controller modules that are wider than one slot. This prevents 

the controller from using peripheral slots.

Star Trigger Slot
Slot 2 is the star trigger slot. This slot has dedicated equal-length trigger 

lines between Slot 2 and peripheral Slots 3 and 4 (refer to Figure 1-3). 

Slot 2 is intended for modules with star trigger functionality that can 

provide individual triggers to all other peripheral modules. However, if 

you do not require advanced trigger functionality, you can install any 

standard peripheral module in this slot.

You also can use the star trigger slot to provide a PXI_CLK10 signal to 

the backplane. For more information regarding PXI_CLK10, refer to the 

System Reference Clock section.

Peripheral Slots
There are three peripheral slots including the star trigger slot.
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Local Bus
The PXI backplane local bus is a daisy-chained bus that connects each 

peripheral slot with adjacent peripheral slots to the left and right as shown 

in Figure 1-3. For example, the Slot 2 right local bus connects to the Slot 3 

left local bus, and so on.

The left local bus signal lines on Slot 2 are used for the star trigger and do 

not connect to Slot 1. The right local bus signal lines on Slot 4 are used for 

SCXI communication.

Each local bus is 13 lines wide and can pass analog signals up to 

42 V between cards or provide a high-speed TTL side-band digital 

communication path that does not reduce the PXI bus bandwidth.

Initialization software uses the configuration information specific to 

adjacent peripheral modules to evaluate local bus compatibility.

SCXI Control Slot
Slot 4 of the PXI backplane has connections for a PXI peripheral module 

such as an NI PXI DAQ module, an NI PXI DMM module, or an 

NI-Switch controller module to control the SCXI subsystem. These 

connections use the available local bus right pins (PXI_LBR0:12). The 

SCXI connection passes communication, timing, and low-voltage analog 

bus signals between the SCXI subsystem and the PXI module in Slot 4.

Note For more information about the local bus right pins, refer to the PXI Specification, 

Revision 2.0.

Trigger Bus
All slots on each PXI bus segment share eight PXI trigger lines. You can 

use these trigger lines in a variety of ways. For example, you can use 

triggers to synchronize the operation of several different PXI peripheral 

modules. In other applications, one module located in Slot 2 can control 

carefully timed sequences of operations performed on other modules in the 

system. Modules can pass triggers to one another, allowing precisely timed 

responses to asynchronous external events the system is monitoring or 

controlling.
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System Reference Clock
The PXI-1052 supplies the PXI 10 MHz system clock signal (PXI_CLK10) 

independently to each peripheral slot. An independent buffer (having a 

source impedance matched to the backplane and a skew of less than 500 ps 

between slots) drives the clock signal to each peripheral slot. You can use 

this common reference clock signal to synchronize multiple modules in a 

measurement or control system. You can drive PXI_CLK10 from an 

external source through the PXI_CLK10_IN pin on the P2 connector of the 

star trigger slot. Refer to Table B-4, P2 (J2) Connector Pinout for the Star 

Trigger Slot. Sourcing an external clock on this pin automatically overrides 

the 10 MHz source of the backplane. Once the transition has been made, 

reset the chassis to restore it to the initial state.

Figure 1-3.  PXI Star Trigger and Local Bus Routing

SCXI Subsystem Overview

To use the SCXI subsystem of the PXI-1052, you must have a 

DAQ/DMM/Switch controller module in Slot 4 of the PXI subsystem 

to control and/or acquire data from the SCXI modules.

Note The chassis address of the SCXI subsystem is hard-wired as 0.

PXI Trigger Bus Segment and  PCI Bus Segment
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2
Installation and Configuration

This chapter describes how to install, configure, and use the PXI-1052 

chassis.

Before connecting the chassis to a power source, read this chapter and the 

Read Me First: Safety and Radio-Frequency Interference document 

included with the chassis.

Safety Information

Caution Before undertaking any troubleshooting, maintenance, or exploratory procedure, 

carefully read the following caution notices.

This equipment contains voltage hazardous to human life and safety, and is 

capable of inflicting personal injury.

• Chassis Grounding—The PXI-1052 requires a connection from the 

earth safety ground to the PXI-1052 chassis ground. The earth safety 

ground must be connected during use of this equipment to minimize 

shock hazards. Refer to the Connecting Safety Ground section for 

instructions on connecting safety ground.

• Live Circuits—Operating personnel and service personnel must not 

remove protective covers when operating or servicing the PXI-1052. 

Adjustments and service to internal components must be undertaken 

by qualified service technicians. During service of this product, the 

main connector to the earth wiring must be disconnected. Dangerous 

voltages may be present under certain conditions; use extreme caution.

• Explosive Atmosphere—Do not operate the chassis in conditions 

where flammable gases are present. Under such conditions this 

equipment is unsafe and can ignite the gases or gas fumes.

• Part Replacement—Only service this equipment with parts that are 

exact replacements, both electrically and mechanically. Contact NI for 

replacement part information. Installation of parts with those that are 

not direct replacements may cause harm to personnel operating the 

chassis. Furthermore, damage or fire may occur if replacement parts 

are unsuitable.
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• Modification—Do not modify any part of the chassis from its original 

condition. Unsuitable modifications may result in safety hazards.

Chassis Cooling Considerations

The PXI-1052 is designed to operate on a bench or in an instrument rack. 

Determine how you want to use the PXI-1052 and follow the appropriate 

installation instructions.

Providing Adequate Clearance
Openings in the top and along both sides of the chassis facilitate power 

supply and module cooling. Air enters through filters and fan inlets in the 

lower rear of the chassis and exits through the upper sections on both sides 

and through the top, as shown in Figure 2-1. Provide adequate ventilation 

space around the PXI-1052 on a bench top or in an instrument rack so that 

the fans (air inlets) and the air outlet apertures along both sides and the top 

of the chassis are not obstructed. Keep other equipment a minimum of 

76.2 mm (3 in.) away from the air inlets on the rear of the chassis.

Figure 2-1.  PXI-1052 Chassis Airflow Side View

When rack mounting the PXI-1052, provide at least 44.5 mm (1.75 in.) 

clearance above and on the sides of the unit for adequate venting. 

High-power applications can require additional clearance.

1 Air Outlets 2 Air Intake

1

2
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Tip Install the chassis so that you can access the rear panel easily. This simplifies cleaning 

or replacing the air filters.

Setting Fan Speed
The fan-speed selector switch is on the rear panel of the PXI-1052. Refer 

to Figure 1-2, Rear View of the PXI-1052 Chassis, to locate the fan-speed 

selector switch. Select HIGH for maximum cooling performance 

(recommended) or AUTO for quieter operation. The fan speed is 

determined by chassis intake air temperature when set to AUTO.

Installing Filler Panels
To improve module cooling performance, install optional PXI filler panels 

in unused slots. Secure the panels with the captive mounting thumbscrews 

provided. You can obtain these panels through NI.

Installing Slot Blockers
You can improve the cooling performance of the chassis by installing 

optional PXI slot blockers. Visit ni.com/support to read the 

NI KnowledgeBase article 2S4928ON, PXI Slot Blockers and 

Improved PXI System Cooling Performance, for more details.

Rack Mounting

Rack-mount applications require one of the optional rack-mount kits 

available from NI. Refer to Figure A-3, PXI-1052 Rack Mount Kit 

Components, and the instructions supplied with the rack-mount kits to 

install the PXI-1052 in an instrument rack.

Note You may want to remove the feet from the PXI-1052 when rack mounting. To do 

so, remove the screws holding the feet in place. 
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Connecting Safety Ground

Caution The PXI-1052 chassis is designed with a three-position NEMA 5-15 style plug 

for the United States that connects the ground line to the chassis ground. To minimize 

shock hazard, make sure the electrical power outlet you use to power the chassis has an 

appropriate earth safety ground.

If the power outlet does not have an appropriate ground connection, you 

must connect the premise safety ground to the chassis grounding screw 

located on the rear panel. Refer to Figure 1-2, Rear View of the PXI-1052 

Chassis, to locate the chassis grounding screw. Complete the following 

steps to connect the safety ground.

1. Connect a 16 AWG (1.3 mm) wire to the chassis grounding screw 

using a grounding lug. The wire must have green insulation with a 

yellow stripe or must be noninsulated (bare).

2. Attach the opposite end of the wire to permanent earth ground using 

toothed washers or a toothed lug.

Connecting to Power Source

Caution Do not install modules prior to performing the following power-on test.

Attach input power through the rear AC inlet using the appropriate 

AC power cable supplied. Refer to Figure 1-2, Rear View of the PXI-1052 

Chassis, to locate the AC inlet.

Caution To completely remove power, you must disconnect the AC power cable.

The power switch allows you to power on the chassis or place it in standby 

mode. Push the power switch to the On (recessed) position (if not already 

on). Observe that all fans become operational and the system power switch 

LED is a steady green. 

The system power indicator LED should be lit indicating that system power 

is available to both the PXI and SCXI subsystems. The PXI subsystem 

remains powered as long as the system power is on. However, you can 

control the SCXI subsystem using the power switch on the rear panel.
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Power Switch LED Indicators

The chassis has two LEDs next to the power switch. The system power 

LED indicates the power status for the chassis. The SCXI power LED, 

when lit, indicates that power is available to the SCXI subsystem. The 

system power LED indicates one of three different conditions.

1. If the system power LED is steady green (not flashing), the chassis is 

powered on and operating normally.

Caution Operating the PXI system outside of the specified temperature range can result in 

loss of data, reduction of chassis life, or damage to equipment. 

2. If the system power LED is flashing green, the air-intake temperature 

has exceeded the chassis operating range. Complete the following 

steps:

a. Power off the system.

b. Unplug the AC power cable.

c. Inspect the chassis for ventilation obstructions and clear them.

d. If the condition persists, contact NI using the information in the 

front of this manual.

Caution Power supply output voltages out of regulation can result in equipment 

malfunction, incorrect data, or failure of system to boot. 

3. If the system power LED is flashing red, the PXI power supply 

outputs are not within voltage regulation requirements. Complete 

the following steps:

a. Power off the system.

b. Unplug the AC power cable.

c. Inspect the chassis for physical damage.

d. Verify that the there is no issue with the AC supply feed to the 

PXI-1052 chassis.

e. If the condition persists, contact NI using the information in the 

front of this manual.
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Installing a PXI Controller

This section contains general instructions for installing a PXI controller in 

the PXI-1052 chassis. Refer to your PXI controller user manual for specific 

instructions and cautions. Complete the following steps to install a 

controller.

1. Plug in the PXI chassis before installing the controller. The power cord 

grounds the chassis and protects it from electrical damage while you 

install the controller. Make sure the chassis power switch is in the Off 

(Standby) position.

Caution To protect yourself and the chassis from electrical hazards, leave the chassis off 

until you complete the controller installation.

2. Install the controller into the system controller slot (Slot 1, indicated 

by the red card guides) by completing the following steps:

a. Place the controller edges into the front controller guides (top and 

bottom). 

b. Slide the controller to the rear of the chassis, making sure that the 

injector/ejector handle is pushed down as shown in Figure 2-2.

 

Figure 2-2.  Injector/Ejector Handle Position during Controller 

or Peripheral Module Insertion
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3. When you begin to feel resistance, pull up on the injector/ejector 

handle to inject the controller fully into the chassis frame. Secure the 

controller front panel to the chassis using the four controller 

front-panel mounting thumbscrews.

4. Connect the keyboard, mouse, and monitor to the appropriate 

connectors. Connect devices to ports as required by your system 

configuration.

5. Power on the chassis. Verify that the controller boots. If the controller 

does not boot, refer to the controller user manual.

Figure 2-3 shows a PXI controller installed in the system controller slot of 

a PXI-1052 chassis. You can place CompactPCI or PXI modules in any 

other slots.

Figure 2-3.  NI PXI Controller Installed in a PXI-1052 Chassis

1 PXI-1052 Chassis 2 Injector/Ejector Rail 3 NI PXI Controller

3

1

2

NI PXI-1052
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Installing PXI Modules

Note Remove any rubber thread protectors from the PXI module mounting thumbscrews 

before you install the module.

Complete the following steps to install a module.

1. Make sure the power switch is in the Off position (NI LEDs on the 

front of the chassis are not lit).

2. Install a module into a chassis slot by completing the following steps:

a. Place the module card edges into the front module guides (top and 

bottom). Refer to Figure 2-4.

b. Slide the module to the rear of the chassis, making sure that the 

injector/ejector handle is pushed down as shown in Figure 2-2. 

3. When you begin to feel resistance, pull up on the injector/ejector 

handle to fully inject the module into the chassis frame. Secure the 

module front panel to the chassis using the two module front-panel 

mounting thumbscrews.
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Figure 2-4.  Installing PXI or CompactPCI Modules

Installing Optional PXI Filler Panels
The PXI filler panels protect the inside of the PXI subsystem by preventing 

unwanted material from entering the PXI-1052 chassis and damaging 

modules or forming conductive paths that can degrade performance. Install 

all PXI modules first, then install PXI filler panels in any unused PXI slots.

Filler panels are the full height of a slot. Complete the following steps to 

install PXI filler panels.

1. Place the filler panel with the captive thumbscrews in front of an 

unused PXI slot. Line up the thumbscrews with the threaded strip 

holes.

2. Using a flathead screwdriver, screw the two captive thumbscrews into 

the threaded strip holes.

1 PXI-1052 Chassis

2 Injector/Ejector Rail

3 Injector/Ejector Handle

4 PXI Module

5 NI PXI Controller

2

1

5

4

3

NI PXI-1052
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Installing SCXI Modules

Notes Remove any rubber thread protectors from the SCXI module mounting 

thumbscrews before you install the module.

Refer to the SCXI module and terminal block documentation for specific instructions 

related to configuration and signal connections.

Complete the following steps to install an SCXI module.

1. Power off the PXI/SCXI chassis using the switch shown in Figure 1-1, 

Front View of the PXI-1052 Chassis. To make sure that the chassis 

power is off, verify that the LEDs are not lit.

2. Insert the module into the module guide rails and slide the module 

to the back of the chassis. Do not force the module into place.

3. Tighten the captive thumbscrews on the front panel of the module to 

secure it in the SCXI subsystem.

Installing Optional SCXI-1360 Filler Panels
The SCXI-1360 filler panels protect the inside of the SCXI subsystem 

by preventing unwanted material from entering the PXI-1052 chassis and 

damaging modules or forming conductive paths that degrade performance. 

Install all SCXI modules first, then install SCXI filler panels in any unused 

SCXI slots.

Filler panels are the full height (4U) of an SCXI slot. Complete the 

following steps to install SCXI-1360 filler panels.

1. Place the filler panel with the captive thumbscrews in front of an 

unused SCXI slot. Line up the thumbscrews with the threaded strip 

holes.

2. Using a flathead screwdriver, screw the two captive thumbscrews into 

the threaded strip holes.

PXI System Configuration with MAX

Configuration of the PXI system is handled through Measurement & 

Automation Explorer (MAX), included on the NI Driver CD packaged with 

NI PXI controllers and devices. MAX creates the pxisys.ini file, which 

defines the layout and parameters of your PXI system. After installing the 
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software on the NI Driver CD, the MAX icon is present on the desktop. 

The configuration steps for single- or multiple-chassis systems are the 

same, and these instructions are valid for either embedded controller-based 

systems or systems controlled through interface with an external PC.

Figure 2-5.  Multichassis Configuration in MAX

Basic PXI System Configuration

1. Launch MAX.

2. In the Configuration tree, click the Devices and Interfaces branch to 

expand it.

3. If the PXI system controller is not configured, it is labeled 

PXI System (Unidentified). Right-click this entry to display the 

context menu and select the appropriate chassis model from the 

Identify As submenu.

Note If your chassis model is not listed, select Other from the list, and then select the 

appropriate chassis.ini file from the NI PXI Resource CD included in your kit.
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4. Click the PXI System controller entry. The chassis (or multiple 

chassis, in a multichassis configuration) is listed below it. Identify each 

chassis by right-clicking its entry and selecting the appropriate chassis 

model through the Identify As submenu. Further expanding the PXI 

System branch shows all of the devices in the system that NI-VISA 

can recognize. Once the controller and all of the chassis are identified, 

MAX will generate the required pxisys.ini file.

5. Apply the chassis number labels, shown in Figure 2-6, included with 

the kit to each chassis in the PXI system, and write in the chassis 

number accordingly in the white space.

Figure 2-6.  Chassis Number Label

Trigger Configuration in MAX
Each chassis has one or more trigger buses, each with eight lines numbered 

0 through 7 that you can reserve and route statically or dynamically. Static 

reservation pre-allocates a trigger line to prevent its configuration by a user 

program. Dynamic reservation/routing/deallocation is automatic within a 

user program based upon NI APIs such as NI-DAQmx. You can implement 

static reservation of trigger lines in MAX through the Triggers tab. 

Reserved trigger lines are not used by PXI modules dynamically 

configured by programs such as NI-DAQmx. This prevents the instruments 

from double-driving the trigger lines, possibly damaging devices in the 

chassis.

Complete the following steps to reserve these trigger lines in MAX.

1. In the Configuration tree, click the PXI chassis branch you want to 

configure.

2. Click the Triggers tab at the bottom of the right-hand pane.

3. Select the trigger lines you want to statically reserve.

4. Click the Apply button.
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Using System Configuration and Initialization Files
The PXI specification allows many combinations of PXI chassis and 

system modules. To assist system integrators, the manufacturers of PXI 

chassis and system modules must document the capabilities of their 

products. The minimum documentation requirements are contained in 

.ini files, which consist of ASCII text. System integrators, configuration 

utilities, and device drivers can use these .ini files.

The capability documentation for the PXI-1052 chassis is contained in the 

chassis.ini file on the software media that comes with the chassis. The 

information in this file is combined with information about the system 

controller to create a single system initialization file called pxisys.ini 

(PXI System Initialization). The system controller manufacturer either 

provides a pxisys.ini file for the particular chassis model that contains 

the system controller or provides a utility that can read an arbitrary 

chassis.ini file and generate the corresponding pxisys.ini file. 

NI system controllers use MAX to generate the pxisys.ini file from the 

chassis.ini file.

Device drivers and other utility software read the pxisys.ini file to 

obtain system information. Device drivers should not need to directly read 

the chassis.ini file. For detailed information regarding initialization 

files, refer to the PXI specification at www.pxisa.org.

SCXI Configuration with MAX

To use the SCXI capabilities of the PXI-1052 chassis, you must configure 

the SCXI portion of the chassis in MAX.

Note Refer to the Hardware Installation Wizard at ni.com/support/install 

for SCXI configuration instructions with RT Series products. Select Hardware 

Configuration and click Real-Time Configuration Wizard.

1. Make sure the SCXI backplane is powered on, since it is powered 

separately from the PXI backplane. The SCXI chassis power switch is 

located on the rear panel of the PXI-1052 chassis.

2. Double-click the Measurement & Automation icon on the desktop to 

launch MAX.

3. Right-click Devices and Interfaces and select Create New.

4. Select the PXI-1052 (SCXI) chassis under NI-DAQmx Device»

NI-DAQmx SCXI Chassis.
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5. Click Finish. A configuration window opens. Refer to the DAQ Quick 

Start Guide included with your kit for more information.

There is an alternative way to add an SCXI chassis. Right-click Devices & 

Interfaces»NI-DAQmx Devices and select Create New NI-DAQmx 

Device. Select NI-DAQmx SCXI Chassis and choose the 

PXI-1052 (SCXI) chassis.

Configure the Chassis
Complete the following steps to configure the chassis.

1. Select whether or not to auto-detect SCXI modules as shown in 

Figure 2-7. If you do not auto-detect modules, MAX disables 

Communicating SCXI Module Slot.

Figure 2-7.  Auto-Detection of Modules in SCXI Chassis

2. Click Save.

3. The SCXI Chassis Configuration window opens. The Modules tab is 

selected by default. If you did not auto-detect modules, select an SCXI 

module from the Modules listbox. Be sure to locate the module in the 

correct slot.

4. MAX provides a default name for the Device Name field. To change 

the name, click in the field and enter a unique alphanumeric ID for the 

SCXI module.

5. If you are using a connected accessory, select it from Accessory.
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6. Click Details for more configuration options. Refer to the Configure 

the SCXI Modules section for more information.

7. If you need to change any chassis settings, click the Chassis tab.

8. Click OK to accept and save the settings for this chassis.

Note You cannot save the chassis configuration until you finish entering module 

information. A message at the top of the SCXI Chassis Configuration window alerts you 

of the status of the configuration. You cannot save if an error appears in the message box. 

If a warning appears in the message box, you can save the configuration, although NI 

recommends fixing the source of the warning before saving.

Configure the SCXI Modules
Complete the following steps to configure the modules. You can skip this 

section if you are using a single MIO device with the SCXI system in 

multiplexed mode.

1. Select the chassis from Devices and Interfaces»NI-DAQmx Devices.

2. Right-click the module and choose Properties.

Note You also can access module properties by selecting the Modules tab of the SCXI 

Chassis Configuration window and clicking Details.

3. Some SCXI modules have jumper-selectable settings. If you are 

configuring such a module, click the Jumpers tab and enter the 

hardware-selected settings.

4. Click the Accessory tab.

5. To change the accessory selected during chassis configuration, select 

a module accessory from the Accessory drop-down listbox.

6. Click Configure to edit accessory settings. Not all accessories have 

settings. Refer to the accessory documentation for more information.

7. If you are using an AI module, click the Cabling tab.
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Note You need not adjust the information in the cabling tab if you are using standard 

multiplexed mode operation. If you are using parallel mode operation, multichassis 

configuration, or another special configuration, adjust the options on the Cabling tab.

8. Select the DAQ device connected to the SCXI module from the Which 

device connects to this module? drop-down listbox. In most cases, 

the device selected here and the module digitizer are the same.

9. Select a DAQ device from the Module Digitizer drop-down listbox. 

The device can be different from the device selected from the Which 

device connects to this module? listbox.

10. If operating in parallel mode, click Parallel Mode.

11. If the module is installed in a daisy-chained chassis, select an index 

number from the Multichassis Daisy-Chain Index drop-down 

listbox. The listbox appears only if two or more chassis have been 

added and saved.

12. Click OK.

For information about software-configurable properties of the module, 

refer to the Measurement & Automation Explorer Help for Traditional 

NI-DAQ or the Measurement & Automation Explorer Help for NI-DAQmx. 

To access this help in MAX, select Help»Help Topics»Traditional 

NI-DAQ or Help»Help Topics»NI-DAQmx.

Test the Chassis
Complete the following steps to verify that MAX recognizes the 

SCXI chassis correctly.

1. Right-click the chassis name in the NI-DAQ API you want to test 

under Devices and Interfaces.

2. Select Test. If you are using NI-DAQmx and the test fails, a message 

explains the failure.

Configure Channels and Tasks
A physical channel is a terminal or pin at which you can measure or 

generate an analog or digital signal. A virtual channel is a collection of 

settings that can include a name, a physical channel, input terminal 

connections, the type of measurement or generation, and scaling 

information. In Traditional NI-DAQ and earlier versions, configuring 

virtual channels is an optional way to record which channels are used for 

different measurements. In NI-DAQmx, virtual channels are integral to 

every measurement.
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In Traditional NI-DAQ, you configure virtual channels using MAX. In 

NI-DAQmx, you can configure virtual channels with the DAQ Assistant, 

which you can open from MAX or your application software. You also can 

configure virtual channels with the NI-DAQmx API in your application 

program. 

A task, an important new concept for NI-DAQmx, is a collection of one 

or more virtual channels with timing, triggering, and other properties. 

Conceptually, a task represents a measurement or generation you want to 

perform. You can set up and save all of the configuration information in a 

task and use the task in an application. 

In NI-DAQmx, you can configure virtual channels as part of a task or 

separate from a task. Virtual channels created inside a task are local 

channels. Virtual channels defined outside a task are global channels. You 

can create global channels in MAX or in your application software and then 

save them in MAX. You can use global channels in any application or add 

them to a number of different tasks. If you modify a global channel, the 

change affects all tasks in which you reference that global channel. In most 

cases, it is simpler to use local channels. 

Configure a Task in NI-DAQmx
Configure tasks with the DAQ Assistant. You must have version 7.0 or 

later of an NI application software package to create tasks and channels 

with the DAQ Assistant. 

• In MAX, right-click Data Neighborhood and select Create New. 

In the Create New window, select NI-DAQmx Task and click Next.

• You also can open the DAQ Assistant directly from within 

NI application software.

– In LabVIEW, there are several ways to open the DAQ Assistant.

• Drop the DAQ Assistant Express VI from the Express Input 

palette, as described in the Getting Started with LabVIEW 

document. 

• You also can use the DAQmx Task Name control to open the 

DAQ Assistant. Right-click the control and select New Task. 

The Taking an NI-DAQmx Measurement in LabVIEW tutorial 

has step-by-step instructions on how to create a task from the 

DAQmx Task Name control and generate code for the task. 

In LabVIEW, select Help»Taking an NI-DAQmx 

Measurement to open the tutorial.
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– In LabWindows™/CVI™, select Tools»Create/Edit DAQmx 

Tasks. 

– In Measurement Studio, open Visual Studio .NET and select 

Project»Add New Item to open the Add New Item dialog box. 

In the Categories pane, select Measurement Studio»Assistants. 

In the Templates pane, select DAQmx Task Class.

Follow the online instructions to create a new task. 

1. Select an I/O type, such as analog input.

2. Select the measurement or generation to perform.

3. Choose the sensor to use, if applicable.

4. Select the channels to add to the task. You can add global channels to 

the task or select physical channels from which to create local channels 

in the task.

5. Configure measurement-specific settings, timing, and triggering, 

if necessary. 

6. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 

LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 

select File»Save. 

You now can use the task in an application. Refer to the DAQ Assistant 

Help or application software documentation for more information about 

using a task or generating code.

Configure Global Channels for NI-DAQmx
Configure global channels with the DAQ Assistant when you use 

NI-DAQmx.

• In MAX, right-click Data Neighborhood and select Create New. 

In the Create New window, select NI-DAQmx Global Channel and 

click Next.

• You also can open the DAQ Assistant directly from within 

LabVIEW 7.0 or later, LabWindows/CVI 7.0 or later, or 

Measurement Studio 7.0 or later. 

– In LabVIEW, use the DAQmx Global Channel control to open the 

DAQ Assistant. Right-click the control and select New Channel 

(DAQ Assistant).
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– In LabWindows/CVI or Measurement Studio, you first must 

create a task as previously described. In the DAQ Assistant, click 

Add Existing DAQmx Global Channels to add global channels 

to your task. 

The DAQ Assistant opens. Follow the online instructions to create a new 

global channel.

1. Select an I/O type, such as analog input. 

2. Select the measurement or generation to perform. 

3. Choose the sensor to use, if applicable. 

4. Select the physical channels to use. 

5. Configure measurement-specific settings. 

6. Save the task.

• If you opened the DAQ Assistant from LabVIEW or 

LabWindows/CVI, click OK. 

• If you opened the DAQ Assistant from Measurement Studio, 

select File»Save. 

You now can use the global channel in an application or add the global 

channel to a task. Refer to the DAQ Assistant Help or application software 

documentation for more information about using a channel or generating 

code.

Note For more information about the NI-DAQmx application programming interface 

(API), refer to the DAQ Quick Start Guide.

Remote Voltage Monitoring and Control

The PXI-1052 chassis supports remote CompactPCI voltage monitoring 

and inhibiting through a male 9-pin D-Sub connector located on the rear 

panel. Table 2-1 shows the pinout of the 9-pin D-Sub connector. 
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You can use the Inhibit signal (active low) to power off the chassis. To 

remotely power off the chassis, connect the Inhibit pin (pin 5) to a Logic 

Ground pin (pins 1 or 9). As long as this connection exists, the chassis 

remains off (standby). When you remove this connection, the chassis 

powers on.

Note For the Inhibit signal to control the On/Off (Standby) state of the chassis, the front 

power switch must be in the On (recessed) position.

Table 2-1.  Remote Inhibit and Voltage Monitoring Connector Pinout

D-Sub Pin Signal

1 Logic Ground

2 +5 VDC

3 Reserved

4 +3.3 VDC

5 Inhibit (Active Low)

6 +12 VDC

7 Reserved

8 –12 VDC

9 Logic Ground

1 2 3 4 5

6 97 8
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Cautions When connecting digital voltmeter probes to the rear 9-pin D-Sub connector, 

be careful not to short the probe leads together. Doing so can damage the power supply.

Use the rear-panel 9-pin D-Sub connector to check voltages only. Do not use the connector 

to supply power to external devices, or you can damage the equipment in the chassis.

You can use a digital voltmeter to ensure all CompactPCI voltage levels in 

the PXI-1052 are within the allowable limits. Referring to Table 2-2, 

connect one lead of the voltmeter to a supply pin on the remote power 

monitoring connector (9-pin D-Sub) on the rear panel. Refer to Table 2-1 

for a pinout diagram of the remote voltage monitoring connector. Connect 

the reference lead of the voltmeter to one of the ground pins. Compare each 

voltage reading to the values listed in Table 2-2.

If the voltages fall within the specified ranges, the chassis complies with 

the CompactPCI voltage-limit specifications.

Table 2-2.  Power Supply Voltages at Voltage Monitoring Connector

Pin Supply Acceptable Voltage Range

2 +5 V 4.75 to 5.25 V

4 +3.3 V 3.135 to 3.465 V

6 +12 V 11.4 to 12.6 V

8 –12 V –12.6 to –11.4 V

1, 9 Logic Ground 0 V
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3
Maintenance

This chapter describes basic maintenance procedures you can perform on 

the PXI-1052 chassis.

Caution Disconnect the power cable prior to servicing the PXI-1052 chassis.

Service Interval

Note Depending on the amount of use and ambient dust levels in the operating 

environment, the filters may require more frequent cleaning.

Clean the chassis fan filters at a maximum interval of six months.

Clean dust from the chassis exterior (and interior) as needed, based on 

the operating environment. Periodic cleaning increases reliability.

Preparation

The information in this chapter is designed for use by qualified service 

personnel. Read the Read Me First: Safety and Radio-Frequency 

Interference document included with the kit before attempting any 

procedures in this chapter.

Caution Many components within the chassis are susceptible to static discharge damage. 

Service the chassis only in a static-free environment. Observe standard handling 

precautions for static-sensitive devices while servicing the chassis. Always wear a 

grounded wrist strap, or equivalent, while servicing the chassis.
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Cleaning

Caution Always disconnect the AC power cable before cleaning or servicing the chassis.

Cleaning procedures consist of exterior and interior cleaning of the chassis 

and cleaning the fan filters. Refer to the module user documentation for 

information on cleaning individual CompactPCI, SCXI, or PXI modules.

Interior Cleaning
Use a dry, low-velocity stream of air to clean the interior of the chassis. 

Use a soft-bristle brush for cleaning around components.

Exterior Cleaning

Cautions Avoid getting water inside the chassis during exterior cleaning, especially 

through the top vents. Use just enough water to dampen the cloth.

Do not wash the front- or rear-panel connectors or switches. Cover these components while 

cleaning the chassis.

Do not use harsh chemical cleaning agents; they can damage the chassis. Avoid chemicals 

that contain benzene, toluene, xylene, acetone, or similar solvents.

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a 

soft-bristle brush. If any dirt remains, wipe with a cloth moistened with 

a mild cleaning agent. Remove any soap residue by wiping with a cloth 

moistened with clear water. Do not use abrasive compounds on any part of 

the chassis.
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Cleaning and Replacing the Fan Filters

Note Power off the chassis and unplug the AC power cable before cleaning or removing 

the fan filters.

Dirty fan filters can dramatically reduce the cooling performance of the 

PXI-1052 chassis. Clean the filters whenever they become visibly dirty. 

You can remove the chassis air filters from the rear of the chassis easily by 

removing the filter retainer. To remove the filter retainer, loosen the retainer 

screws. The filter cover and retainer are shown in Figure 1-2, Rear View of 

the PXI-1052 Chassis.

Clean the fan filters by washing them with a mild cleaning agent and then 

vacuuming or blowing air through them. Rinse the filters with water and 

allow them to dry before reinstalling them on the chassis.

You can purchase the same filter media in sheets, and make a filter 

replacement.

Resetting the AC Mains Circuit Breaker

If the PXI-1052 encounters an over-current condition, the circuit breaker 

on the rear panel trips to prevent damage to the chassis. Complete the 

following steps to reset the circuit breaker.

1. Press the front panel power switch to the Off (Standby) position.

2. Disconnect the AC power cable.

3. Depress the circuit breaker to reset it.

4. Reconnect the AC power cable.

5. Press the power switch to the On position.

If the circuit breaker trips again, complete the following steps:

1. Press the front panel power switch to the Off (Standby) position.

2. Disconnect the AC power cable.

3. Remove all modules from the chassis.

4. Complete the procedure described in the Connecting to Power Source 

section of Chapter 2, Installation and Configuration. If the system 

power switch LED is not a steady green, contact NI through the 

information given in Appendix C, Technical Support and Professional 

Services.
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5. Verify that the PXI-1052 can meet the power requirements of the 

installed CompactPCI, SCXI, or PXI modules. Overloading the 

chassis can cause the breaker to trip. Refer to Appendix A, 

Specifications.

6. The over-current condition that caused the circuit breaker to trip can 

be due to a faulty CompactPCI, SCXI, or PXI module. Refer to the 

documentation supplied with the modules for troubleshooting 

information.
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A
Specifications

Caution If the PXI-1052 chassis is used in a manner inconsistent with the instructions or 

specifications listed by NI, the protective features of the chassis may be impaired. 

This appendix contains specifications for the PXI-1052 chassis.

Electrical

AC Input
Input voltage range................................. 100–240 VAC

Operating voltage range1........................ 90–264 VAC

Input frequency ...................................... 50/60 Hz

Operating frequency range1 ................... 47–63 Hz

Input current rating................................. 6–3 A

Over-current protection.......................... 10 A circuit breaker

Installation Category .............................. II

Efficiency ............................................... 70% minimum

1   The operating range is guaranteed by design.
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Power disconnect ....................................The AC power cable provides 

main power disconnect. 

Depressing the front-panel power 

switch controls the internal 

chassis power supply that 

provides DC power to the 

CompactPCI/PXI backplane. You 

also can use the rear-panel 9-pin 

D-Sub connector to control the 

internal chassis power supply. 

DC Output
DC current capacity (IMP)

Maximum ripple and noise (20 MHz bandwidth)

Voltage 0–50 °C 50–55 °C

+3.3 V 12 A 12 A

+5 V 17 A 17 A

+12 V 2 A 2 A

–12 V 1 A 1 A

+20 V 1.36 A 1.16 A

–20 V 1.36 A 1.16 A

Voltage Maximum Ripple and Noise

+3.3 V 50 mVpp

+12 V 120 mVpp

+5 V  50 mVpp

–12 V  120 mVpp

+20 V  200 mVpp

–20 V  200 mVpp
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Over-current protection.......................... All outputs protected from short 

circuit and overload with 

automatic recovery when the 

short or overload is removed.

Overvoltage protection1 ......................... 115 to 140% above nominal 

output voltage

PXI Subsystem Cooling
Per slot cooling capacity ........................ 25 W with fan speed set to HIGH

Slot airflow direction ............................. P1 to P2, bottom of module 

to top of module

Module cooling

System............................................. Forced air circulation (positive 

pressurization) using one 115 cfm 

fan with HIGH/AUTO speed 

selector

Intake .............................................. Bottom rear of chassis

Exhaust............................................ Along both sides and top of 

chassis

Power supply cooling

System............................................. Forced air circulation through 

integrated fan

Intake .............................................. Right side of chassis

Exhaust............................................ Left side of chassis

Safety
The PXI-1052 was evaluated using the criteria of EN 61010-1 and meets 

the requirements of the following standards for safety and electrical 

equipment for measurement, control, and laboratory use:

• EN 61010-1, IEC 61010-1

• UL 3111-1, UL 61010B-1

• CAN/CSA C22.2 No. 1010.1

1   To reset over-voltage protection, remove the AC power cable for 30 seconds and then restore power.
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Note For UL and other safety certifications, refer to the product label, or visit 

ni.com/hardref.nsf, search by model number or product line, and click the 

appropriate link in the Certification column.

Electromagnetic Compatibility
Emissions................................................EN 55011 Class A at 10 m

FCC Part 15A above 1 GHz

Immunity ................................................EN 61326:1997 + A2:2001, 

Table 1

EMC/EMI ...............................................CE, C-Tick, and FCC Part 15 

(Class A) compliant

Notes For EMC compliance, you must operate this device with shielded cabling. 

In addition, all covers and filler panels must be installed.

CE Compliance
This product meets the essential requirements of applicable European 

Directives, as amended for CE marking, as follows:

Low-Voltage Directive (safety)..............73/23/EEC

Electromagnetic Compatibility

Directive (EMC) .....................................89/336/EEC

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 

regulatory compliance information. To obtain the DoC for this product, visit 

ni.com/hardref.nsf, search by model number or product line, and click the 

appropriate link in the Certification column.
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Operating Environment
Indoor use only

Ambient temperature range.................... 0 to 55 °C (Tested in accordance 

with IEC-60068-2-1 and 

IEC-60068-2-2.)

Operating relative humidity ................... 10 to 90%, noncondensing 

(Tested in accordance with 

IEC-60068-2-56.)

Altitude................................................... 2,000 m (at 25 °C ambient 

temperature)

Pollution Degree .................................... 2

Storage Environment
Ambient temperature range.................... –20 to 70 °C (Tested in 

accordance with IEC-60068-2-1 

and IEC-60068-2-2.)

Storage relative humidity ....................... 5 to 95%, noncondensing 

(Tested in accordance with 

IEC-60068-2-56.)

Shock and Vibration
Operational shock .................................. 30 g peak, half-sine, 11 ms pulse 

(Tested in accordance with 

IEC-60068-2-27. Test profile 

developed in accordance with 

MIL-PRF-28800F.)

Random Vibration

Operating ........................................ 5 to 500 Hz, 0.3 grms

Nonoperating .................................. 5 to 500 Hz, 2.4 grms

(Tested in accordance with 

IEC-60068-2-64. Nonoperating 

test profile exceeds the 

requirements of 

MIL-PRF-28800F, Class 3.)
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Backplane
Size .........................................................3U-sized; one system slot 

(with three system expansion 

slots) and 3 peripheral slots.

Compliant with IEEE 1101.10 

mechanical packaging.

PXI Hardware Specification, 

Revision 2.1 compliant.

Accepts both PXI and 

CompactPCI (PICMG 2.0 R 3.0) 

3U modules.

V(I/O)1 ....................................................+5 V

Backplane bare-board material ...............UL 94 V-0 recognized

Backplane connectors .............................Conforms to IEC 917 and 

IEC 1076-4-101, and are 

UL 94 V-0 rated

10 MHz System Reference Clock (10 MHz REF)
Maximum clock skew

between slots...........................................500 ps

Built-in 10 MHz clock

Accuracy..........................................±100 ppm (guaranteed over the 

operating temperature range)

Maximum jitter................................15 ps RMS in 10 Hz to 1 MHz 

range

Mechanical
Overall dimensions (standard chassis)

Height × Width × Depth ..................177 mm × 438.2 mm × 452.9 mm

(6.97 in.) × 17.25 in. × 17.83 in.)

Note 14.5 mm (0.57 in.) is added to height when feet are installed. When tilted with front 

feet extended on table top, height is increased approximately 52.8 mm (2.08 in.) in front 

and 14.8 mm (0.583 in.) in rear.

1   V(I/O) is connected to the +5 V DC power plane, so the same specs apply to V(I/O) and +5 V.
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Weight .................................................... 10 kg (22.0 lbs)

Chassis materials.................................... Sheet aluminum 

(EN AW-5754-H22, 

EN AW-5005-H14), extruded 

aluminum (6063-T6), cold rolled 

steel, PC/ABS, Santoprene, nylon

Finish...................................................... Conductive clear Iridite 

on aluminum, clear chromate zinc 

on cold rolled steel, electroplated 

nickel on cold rolled steel, 

epoxy/polyester powder coat.
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Figure A-1 and Figure A-2 show the PXI-1052 dimensions. The holes 

shown are for the installation of the optional rack-mount kits as shown in 

Figure A-3. The front and rear rack mounting holes (size M4) are 

symmetrical.

Figure A-1.  PXI-1052 Dimensions (Front and Side) in Inches (mm)

17.84 [453.1]

2.32 [58.8]

3.751 [95.26]

1.875 [47.63]

1.28 [32.4]

4.557 [115.75]

14.47 [367.5]

1.73 [44.0]

6.97 [177.0]

0.57 [14.5]

17.25 [438.2]
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Figure A-2.  PXI-1052 Dimensions (Bottom) in Inches (mm)

14.66 [372.3]

0.95 [24.1]

1.13 [28.6]

15.00 [381.0]
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Figure A-3.  PXI-1052 Rack Mount Kit Components

1 Front Rack-Mount Kit 2 PXI-1052 Chassis 3 Rear Rack-Mount Kit

1

2

1

3
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B
Pinouts

This appendix describes the P1 and P2 connector pinouts for the PXI-1052 

backplane.

Table B-1 shows the P1 (J1) connector pinout for the System 

Controller slot.

Table B-2 shows the P2 (J2) connector pinout for the System 

Controller slot.

Table B-3 shows the P1 (J1) connector pinout for the star trigger slot.

Table B-4 shows the P2 (J2) connector pinout for the star trigger slot.

Table B-5 shows the P1 (J1) connector pinout for the peripheral slots.

Table B-6 shows the P2 (J2) connector pinout for the peripheral slots.

Note PXI signals are shown in bold. 

For more detailed information, refer to the PXI Hardware Specification, 

Revision 2.1. Contact the PXI Systems Alliance for a copy of the 

specification or visit www.pxisa.org.
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Table B-1.  P1 (J1) Connector Pinout for the System Controller Slot

Pin Z A B C D E F

25 GND 5V REQ64# ENUM# 3.3V 5V GND

24 GND AD[1] 5V V(I/O) AD[0] ACK64# GND

23 GND 3.3V AD[4] AD[3] 5V AD[2] GND

22 GND AD[7] GND 3.3V AD[6] AD[5] GND

21 GND 3.3V AD[9] AD[8] M66EN C/BE[0]# GND

20 GND AD[12] GND V(I/O) AD[11] AD[10] GND

19 GND 3.3V AD[15] AD[14] GND AD[13] GND

18 GND SERR# GND 3.3V PAR C/BE[1]# GND

17 GND 3.3V IPMB_SCL IPMB_SDA GND PERR# GND

16 GND DEVSEL# GND V(I/O) STOP# LOCK# GND

15 GND 3.3V FRAME# IRDY# GND TRDY# GND

12–14 Key Area

11 GND AD[18] AD[17] AD[16] GND C/BE[2]# GND

10 GND AD[21] GND 3.3V AD[20] AD[19] GND

9 GND C/BE[3]# GND AD[23] GND AD[22] GND

8 GND AD[26] GND V(I/O) AD[25] AD[24] GND

7 GND AD[30] AD[29] AD[28] GND AD[27] GND

6 GND REQ0# GND 3.3V CLK0 AD[31] GND

5 GND BRSVP1A5 BRSVP1B5 RST# GND GNT0# GND

4 GND IPMB_PWR HEALTHY V(I/O) INTP INTS GND

3 GND INTA# INTB# INTC# 5V INTD# GND

2 GND TCK 5V TMS TDO TDI GND

1 GND 5V  –12V TRST#  +12V 5V GND
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Table B-2.  P2 (J2) Connector Pinout for the System Controller Slot

Pin Z A B C D E F

22 GND GA4 GA3 GA2 GA1 GA0 GND

21 GND CLK6 GND RSV RSV RSV GND

20 GND CLK5 GND RSV GND RSV GND

19 GND GND GND SMB_SDA SMB_SCL SMB_ALERT# GND

18 GND PXI_TRIG3 PXI_TRIG4 PXI_TRIG5 GND PXI_TRIG6 GND

17 GND PXI_TRIG2 GND PRST# REQ6# GNT6# GND

16 GND PXI_TRIG1 PXI_TRIG0 DEG# GND PXI_TRIG7 GND

15 GND PXI_BRSVA15 GND FAL# REQ5# GNT5# GND

14 GND AD[35] AD[34] AD[33] GND AD[32] GND

13 GND AD[38] GND V(I/O) AD[37] AD[36] GND

12 GND AD[42] AD[41] AD[40] GND AD[39] GND

11 GND AD[45] GND V(I/O) AD[44] AD[43] GND

10 GND AD[49] AD[48] AD[47] GND AD[46] GND

9 GND AD[52] GND V(I/O) AD[51] AD[50] GND

8 GND AD[56] AD[55] AD[54] GND AD[53] GND

7 GND AD[59] GND V(I/O) AD[58] AD[57] GND

6 GND AD[63] AD[62] AD[61] GND AD[60] GND

5 GND C/BE[5]# GND V(I/O) C/BE[4]# PAR64 GND

4 GND V(I/O) PXI_BRSVB4 C/BE[7]# GND C/BE[6]# GND

3 GND CLK4 GND GNT3# REQ4# GNT4# GND

2 GND CLK2 CLK3 SYSEN# GNT2# REQ3# GND

1 GND CLK1 GND REQ1# GNT1# REQ2# GND
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Table B-3.  P1 (J1) Connector Pinout for the Star Trigger Slot

Pin Z A B C D E F

25 GND 5V REQ64# ENUM# 3.3V 5V GND

24 GND AD[1] 5V V(I/O) AD[0] ACK64# GND

23 GND 3.3V AD[4] AD[3] 5V AD[2] GND

22 GND AD[7] GND 3.3V AD[6] AD[5] GND

21 GND 3.3V AD[9] AD[8] M66EN C/BE[0]# GND

20 GND AD[12] GND V(I/O) AD[11] AD[10] GND

19 GND 3.3V AD[15] AD[14] GND AD[13] GND

18 GND SERR# GND 3.3V PAR C/BE[1]# GND

17 GND 3.3V IPMB_SCL IPMB_SDA GND PERR# GND

16 GND DEVSEL# GND V(I/O) STOP# LOCK# GND

15 GND 3.3V FRAME# IRDY# BD_SEL# TRDY# GND

12–14 Key Area

11 GND AD[18] AD[17] AD[16] GND C/BE[2]# GND

10 GND AD[21] GND 3.3V AD[20] AD[19] GND

9 GND C/BE[3]# IDSEL AD[23] GND AD[22] GND

8 GND AD[26] GND V(I/O) AD[25] AD[24] GND

7 GND AD[30] AD[29] AD[28] GND AD[27] GND

6 GND REQ# GND 3.3V CLK AD[31] GND

5 GND BRSVP1A5 BRSVP1B5 RST# GND GNT# GND

4 GND IPMB_PWR HEALTHY V(I/O) INTP INTS GND

3 GND INTA# INTB# INTC# 5V INTD# GND

2 GND TCK 5V TMS TDO TDI GND

1 GND 5V –12V TRST#  +12V 5V GND
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Table B-4.  P2 (J2) Connector Pinout for the Star Trigger Slot

Pin Z A B C D E F

22 GND GA4 GA3 GA2 GA1 GA0 GND

21 GND PXI_LBR0 RSV PXI_LBR1 PXI_LBR2 PXI_LBR3 GND

20 GND PXI_LBR4 PXI_LBR5 PXI_STAR0 GND PXI_STAR1 GND

19 GND PXI_STAR2 RSV PXI_STAR3 PXI_STAR4 PXI_STAR5 GND

18 GND PXI_TRIG3 PXI_TRIG4 PXI_TRIG5 GND PXI_TRIG6 GND

17 GND PXI_TRIG2 GND RSV PXI_CLK10_IN PXI_CLK10 GND

16 GND PXI_TRIG1 PXI_TRIG0 RSV GND PXI_TRIG7 GND

15 GND PXI_BRSVA15 GND RSV PXI_STAR6 PXI_LBR6 GND

14 GND AD[35] AD[34] AD[33] GND AD[32] GND

13 GND AD[38] GND V(I/O) AD[37] AD[36] GND

12 GND AD[42] AD[41] AD[40] GND AD[39] GND

11 GND AD[45] GND V(I/O) AD[44] AD[43] GND

10 GND AD[49] AD[48] AD[47] GND AD[46] GND

9 GND AD[52] GND V(I/O) AD[51] AD[50] GND

8 GND AD[56] AD[55] AD[54] GND AD[53] GND

7 GND AD[59] GND V(I/O) AD[58] AD[57] GND

6 GND AD[63] AD[62] AD[61] GND AD[60] GND

5 GND C/BE[5]# GND V(I/O) C/BE[4]# PAR64 GND

4 GND V(I/O) PXI_BRSVB4 C/BE[7]# GND C/BE[6]# GND

3 GND PXI_LBR7 GND PXI_LBR8 PXI_LBR9 PXI_LBR10 GND

2 GND PXI_LBR11 PXI_LBR12 UNC PXI_STAR7 PXI_STAR8 GND

1 GND PXI_STAR9 GND PXI_STAR10 PXI_STAR11 PXI_STAR12 GND
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Table B-5.  P1 (J1) Connector Pinout for the Generic Peripheral Slot

Pin Z A B C D E F

25 GND 5V REQ64# ENUM# 3.3V 5V GND

24 GND AD[1] 5V V(I/O) AD[0] ACK64# GND

23 GND 3.3V AD[4] AD[3] 5V AD[2] GND

22 GND AD[7] GND 3.3V AD[6] AD[5] GND

21 GND 3.3V AD[9] AD[8] M66EN C/BE[0]# GND

20 GND AD[12] GND V(I/O) AD[11] AD[10] GND

19 GND 3.3V AD[15] AD[14] GND AD[13] GND

18 GND SERR# GND 3.3V PAR C/BE[1]# GND

17 GND 3.3V IPMB_SCL IPMB_SDA GND PERR# GND

16 GND DEVSEL# GND V(I/O) STOP# LOCK# GND

15 GND 3.3V FRAME# IRDY# BD_SEL# TRDY# GND

12–14 Key Area

11 GND AD[18] AD[17] AD[16] GND C/BE[2]# GND

10 GND AD[21] GND 3.3V AD[20] AD[19] GND

9 GND C/BE[3]# IDSEL AD[23] GND AD[22] GND

8 GND AD[26] GND V(I/O) AD[25] AD[24] GND

7 GND AD[30] AD[29] AD[28] GND AD[27] GND

6 GND REQ# GND 3.3V CLK AD[31] GND

5 GND BRSVP1A5 BRSVP1B5 RST# GND GNT# GND

4 GND IPMB_PWR HEALTHY V(I/O) INTP INTS GND

3 GND INTA# INTB# INTC# 5V INTD# GND

2 GND TCK 5V TMS TDO TDI GND

1 GND 5V  –12V TRST#  +12V 5V GND



Appendix B Pinouts

© National Instruments Corporation B-7 NI PXI-1052 User Manual

Table B-6.  P2 (J2) Connector Pinout for the Generic Peripheral Slot

Pin Z A B C D E F

22 GND GA4 GA3 GA2 GA1 GA0 GND

21 GND PXI_LBR0 RSV PXI_LBR1 PXI_LBR2 PXI_LBR3 GND

20 GND PXI_LBR4 PXI_LBR5 PXI_LBL0 GND PXI_LBL1 GND

19 GND PXI_LBL2 RSV PXI_LBL3 PXI_LBL4 PXI_LBL5 GND

18 GND PXI_TRIG3 PXI_TRIG4 PXI_TRIG5 GND PXI_TRIG6 GND

17 GND PXI_TRIG2 GND RSV PXI_STAR PXI_CLK10 GND

16 GND PXI_TRIG1 PXI_TRIG0 RSV GND PXI_TRIG7 GND

15 GND PXI_BRSVA15 GND RSV PXI_LBL6 PXI_LBR6 GND

14 GND AD[35] AD[34] AD[33] GND AD[32] GND

13 GND AD[38] GND V(I/O) AD[37] AD[36] GND

12 GND AD[42] AD[41] AD[40] GND AD[39] GND

11 GND AD[45] GND V(I/O) AD[44] AD[43] GND

10 GND AD[49] AD[48] AD[47] GND AD[46] GND

9 GND AD[52] GND V(I/O) AD[51] AD[50] GND

8 GND AD[56] AD[55] AD[54] GND AD[53] GND

7 GND AD[59] GND V(I/O) AD[58] AD[57] GND

6 GND AD[63] AD[62] AD[61] GND AD[60] GND

5 GND C/BE[5]# GND V(I/O) C/BE[4]# PAR64 GND

4 GND V(I/O) PXI_BRSVB4 C/BE[7]# GND C/BE[6]# GND

3 GND PXI_LBR7 GND PXI_LBR8 PXI_LBR9 PXI_LBR10 GND

2 GND PXI_LBR11 PXI_LBR12 UNC PXI_LBL7 PXI_LBL8 GND

1 GND PXI_LBL9 GND PXI_LBL10 PXI_LBL11 PXI_LBL12 GND
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C
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 

ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 

visit our extensive library of technical support resources available 

in English, Japanese, and Spanish at ni.com/support. These 

resources are available for most products at no cost to registered 

users and include software drivers and updates, a KnowledgeBase, 

product manuals, step-by-step troubleshooting wizards, 

conformity documentation, example code, tutorials and 

application notes, instrument drivers, discussion forums, 

a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 

measurement and automation professionals by visiting 

ni.com/support. Our online system helps you define your 

question and connects you to the experts by phone, discussion 

forum, or email.

• Training and Certification—Visit ni.com/training for 

self-paced training, eLearning virtual classrooms, interactive CDs, 

and Certification program information. You also can register for 

instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, NI Alliance Program 

members can help. To learn more, call your local NI office or visit 

ni.com/alliance.

• Declaration of Conformity (DoC)—A DoC is our claim of 

compliance with the Council of the European Communities using 

the manufacturer’s declaration of conformity. This system affords 

the user protection for electronic compatibility (EMC) and product 

safety. You can obtain the DoC for your product by visiting 

ni.com/hardref.nsf.
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If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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Glossary

Symbol Prefix Value

p pico 10–12

n nano 10–9

µ micro 10– 6

m milli 10–3

k kilo 103

M mega 106

G giga 109

T tera 1012

Symbols

° Degrees.

≥ Equal or greater than.

≤ Equal or less than.

% Percent.

Ω Ohms.

A

A Amperes.

AC Alternating current.

ANSI American National Standards Institute.

AUTO Automatic fan speed control.

AWG American Wire Gauge.
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B

backplane An assembly, typically a printed circuit board, with connectors and signal 

paths that interconnect the connector pins.

BNC Bayonet Neill Concelman connector; a commonly used coaxial connector.

C

C Celsius.

cfm Cubic feet per minute.

CFR Code of Federal Regulations.

cm Centimeters.

CompactPCI An adaptation of the Peripheral Component Interconnect (PCI) 

Specification 2.1 or later for industrial and/or embedded applications 

requiring a more robust mechanical form factor than desktop PCI. It 

uses industry standard mechanical components and high-performance 

connector technologies to provide an optimized system intended for rugged 

applications. It is electrically compatible with the PCI Specification, which 

enables low-cost PCI components to be utilized in a mechanical form factor 

suited for rugged environments.

CSA Canadian Standards Association.

D

daisy-chain A method of propagating signals along a bus, in which the devices are 

prioritized on the basis of their position on the bus.

DB-9 A 9-pin D-Sub connector.

DC Direct current.

DoC Declaration of Conformity.

D-Sub Subminiature D connector.
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E

efficiency Ratio of output power to input power, expressed as a percentage.

EIA Electronic Industries Association.

EMC Electromagnetic Compatibility.

EMI Electromagnetic Interference.

Embedded system 

controller

A module configured for installation in slot 1 of a PXI chassis. This device 

is unique in the PXI system in that it performs the system controller 

functions, including clock sourcing and arbitration for data transfers across 

the backplane. Installing such a device into any other slot can damage the 

device, the PXI backplane, or both. 

F

FCC Federal Communications Commission.

filler panel A blank module front panel used to fill empty slots in the chassis.

G

g (1) grams; (2) a measure of acceleration approximately equal to 9.8 m/s2.

global channel A virtual channel created outside of a task. A virtual channel defined inside 

a task is a local channel.

GPIB General Purpose Interface Bus (IEEE 488).

gRMS A measure of random vibration. The root mean square of acceleration 

levels in a random vibration test profile.

H

hr Hours.

Hz Hertz; cycles per second.
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I

IEC International Electrotechnical Commission; an organization that sets 

international electrical and electronics standards.

IEEE Institute of Electrical and Electronics Engineers.

IMP Mainframe peak current.

in. Inches.

inhibit To power off.

J

jitter A measure of the small, rapid variations in clock transition times from their 

nominal regular intervals. Units: seconds RMS.

K

kg Kilograms.

km Kilometers.

L

lb Pounds.

LED Light emitting diode.

line regulation The maximum steady-state percentage that a DC voltage output changes as 

a result of a specified change in input AC voltage (step change from 90 to 

132 VAC or 180 to 264 VAC).

load regulation The maximum steady-state percentage that a DC voltage output changes as 

a result of a step change from no-load to full-load output current.

local channel A virtual channel created inside a task. A virtual channel defined outside 

of a task is a global channel.
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M

m Meters.

MAX NI Measurement & Automation Explorer, the utility that allows you to 

configure and test the PXI system.

MHz Megahertz. One million Hertz; one Hertz equals one cycle per second.

ms Millisecond, one thousandth of a second (10–3).

MTBF Mean time between failure.

MTTR Mean time to repair.

N

NEMA National Electrical Manufacturers Association.

NI National Instruments.

NI-DAQmx National Instruments driver which controls the operation of National 

Instruments data acquisition (DAQ) devices.

NI-VISA National Instruments implementation of the VISA (Virtual Instrument 

System Architecture) I/O standard. NI-VISA provides support for the 

VISA API, and also provides VISAIC, a utility for instrument 

configuration and I/O function execution.

ns Nanosecond, one billionth of a second (10–9).

P

physical channel A terminal or pin at which you can measure or generate an analog or digital 

signal.

ppm Parts-per-million.

power-supply shuttle A removable module that contains the chassis power supply.

ps Picosecond, one trillionth of a second (10–12).
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PXI PCI eXtensions for Instrumentation. PXI is an implementation of 

CompactPCI with added electrical features that meet the high performance 

requirements of instrumentation applications by providing triggering, local 

buses, and system clock capabilities.

PXI_CLK10 10 MHz PXI system reference clock.

R

RMS Root mean square.

S

s Seconds.

skew Deviation in signal transmission times.

slot blocker An assembly installed into an empty slot to improve the airflow in adjacent 

slots.

standby The backplane is unpowered (off), but the chassis is still connected to 

AC power mains.

star trigger slot This slot is located at Slot 2 and has a dedicated trigger line between each 

peripheral slot. Use this slot for a module with star trigger functionality that 

can provide individual triggers to all other peripherals.

system reference 

clock

A 10 MHz clock, also called PXI_CLK10, that is distributed to all 

peripheral slots in the chassis. The system reference clock is used for 

synchronization of multiple modules in a measurement or control system. 

The PXI backplane specification defines implementation guidelines for 

PXI_CLK10.

T

task In NI-DAQmx, a collection of one or more virtual channels with timing, 

triggering, and other properties. 

TTL Transistor-transistor logic.
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U

UL Underwriter’s Laboratories.

V

V Volts.

VAC Volts alternating current, or Vrms.

virtual channel A collection of settings that can include a name, a physical channel, input 

terminal connections, the type of measurement or generation, and scaling 

information. In Traditional NI-DAQ and earlier versions, configuring 

virtual channels is an optional way to record which channels are being used 

for different measurements. In NI-DAQmx, virtual channels are integral to 

every measurement.

Vpp Peak-to-peak voltage.

W

W Watts.
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Index

A
AC power cables (table), 1-2

B
backplane

interoperability with CompactPCI, 1-6

local bus, 1-7

overview, 1-5

peripheral slots, 1-6

specifications, A-6

star trigger slot, 1-6

system reference clock, 1-8

trigger bus, 1-7

C
cables, power (table), 1-2

chassis initialization file, 2-13

CompactPCI

installing modules (figure), 2-9

interoperability with PXI-1052 

backplane, 1-6

configuration. See installation, configuration, 

and operation

connector pinouts. See pinouts

conventions used in the manual, vii

cooling

air cooling of PXI-1052, 2-2

air intake (figure), 2-2

filler panel installation, 2-3

setting fan speed, 2-3

slot blocker installation, 2-3

customer

professional services, C-1

technical support, C-1

D
Declaration of Conformity (NI resources), C-1

diagnostic tools (NI resources), C-1

dimensions (figure), A-8, A-9

documentation

conventions used in manual, vii

related documentation, viii

drivers (NI resources), C-1

D-Sub connector

pinout (table), 2-20

power supply voltages (table), 2-21

E
electromagnetic compatibility, A-4

examples (NI resources), C-1

F
fan, setting speed, 2-3

filler panel installation, 2-3

SCXI subsystem, 2-9, 2-10

G
ground, connecting, 2-4

H
help

professional services, C-1

technical support, C-1
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I
installation

SCXI filler panels, 2-9, 2-10

SCXI modules, 2-10

installation, configuration, and operation

chassis initialization file, 2-13

configuration in MAX (figure), 2-11

connecting safety ground, 2-4

filler panel installation, 2-3

installing a PXI controller, 2-6

module installation, 2-6, 2-8

CompactPCI or PXI modules 

(figure), 2-9

injector/ejector handle position 

(figure), 2-6

PXI configuration in MAX, 2-10

trigger configuration, 2-12

PXI controller installed in a PXI-1052 

chassis (figure), 2-7

rack mounting, 2-3

remote voltage monitoring and inhibiting 

connector, 2-19

setting fan speed, 2-3

site considerations, 2-2

slot blocker installation, 2-3

testing power up, 2-4

unpacking the PXI-1052, 1-1

instrument drivers (NI resources), C-1

interoperability with CompactPCI, 1-6

K
key features, 1-2

kit contents, 1-1

KnowledgeBase, C-1

L
local bus

routing (figure), 1-7

star trigger and local bus routing 

(figure), 1-8

M
maintenance of PXI-1052, 3-1

cleaning

exterior cleaning, 3-2

fan filters, 3-3

interior cleaning, 3-2

preparation, 3-1

resetting the AC mains circuit 

breaker, 3-3

service interval, 3-1

static discharge damage (caution), 3-1

N
National Instruments

professional services, C-1

technical support, C-1

National Instruments support and 

services, C-1

O
online technical support, C-1

optional equipment, 1-5

P
P1 (J1) connector

peripheral slot (table), B-6

star trigger slot (table), B-4

system controller slot (table), B-2
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P2 (J2) connector

peripheral slot (table), B-7

star trigger slot (table), B-5

system controller slot (table), B-3

peripheral slots

overview, 1-6

P1 (J1) connector pinouts (table), B-6

P2 (J2) connector pinouts (table), B-7

pinouts, B-1

D-Sub connector (table), 2-20

P1 (J1) connector

peripheral slot (table), B-6

star trigger slot (table), B-4

system controller slot (table), B-2

P2 (J2) connector

peripheral slot (table), B-7

star trigger slot (table), B-5

system controller slot (table), B-3

power cables (table), 1-2

power supply

connecting to, 2-4

remote voltage monitoring and inhibiting 

connector, 2-19

voltages at voltage monitoring connector 

(D-Sub) (table), 2-20

power switch LED indicators, 2-5

power up, testing, 2-4

professional services, C-1

programming examples (NI resources), C-1

PXI controller, 2-6

installing in a PXI-1052 chassis 

(figure), 2-7

PXI subsystem

SCXI control slot, 1-7

star trigger and local bus routing 

(figure), 1-8

PXI_CLK10, 1-8

PXI_CLK10_IN pin, 1-8

PXI-1011 chassis. See PXI subsystem

PXI-1052

cooling air intake (figure), 2-2

fan speed, setting, 2-3

front view (figure), 1-4

installation. See installation, 

configuration, and operation

key features, 1-2

maintenance. See maintenance of 

PXI-1052

optional equipment, 1-5

rack mounting, 2-3

rear view of chassis, 1-5

safety ground, connecting, 2-4

PXI-1052 backplane

interoperability with CompactPCI, 1-6

local bus, 1-7

overview, 1-5

peripheral slots, 1-6

specifications, A-6

star trigger slot, 1-6

system reference clock, 1-8

trigger bus, 1-7

PXI-1052 chassis

SCXI subsystem overview, 1-8

R
rack mount kit dimensions (figure), A-10

rack mounting, 2-3

related documentation, viii

remote voltage monitoring and inhibiting

connector

pinout (table), 2-19

power supply voltages (table), 2-21

S
safety and caution notices, 2-1

safety ground, connecting, 2-4

safety specifications (table), A-3
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SCXI subsystem

control slot for PXI peripheral 

module, 1-7

installation, filler panel, 2-10

overview, 1-8

service interval, 3-1

setting fan speed, 2-3

slot blocker, installation, 2-3

software (NI resources), C-1

specifications

backplane, A-6

dimensions (figure), A-8, A-9

electrical

AC input, A-1

DC output, A-2

electromagnetic compatibility, A-4

environmental, A-5

mechanical, A-6

pxi subsystem cooling, A-3

rack mount kit dimensions (figure), A-10

safety, A-3

star trigger (ST) slot

description, 1-6

P1 (J1) connector pinouts (table), B-4

P2 (J2) connector pinouts (table), B-5

star trigger and local bus routing 

(figure), 1-8

support, technical, C-1

system controller slot

description, 1-6

P1 (J1) connector pinouts (table), B-2

P2 (J2) connector pinouts (table), B-3

system reference clock, 1-8

T
technical support, C-1

testing power up, 2-4

training and certification (NI resources), C-1

trigger bus, 1-7

troubleshooting (NI resources), C-1

U
unpacking the PXI-1052, 1-1

V
voltage monitoring connector. See D-Sub 

connector

voltages at voltage monitoring connector 

(D-Sub) (table), 2-21

W
Web

professional services, C-1

technical support, C-1
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